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Welcome to the ChefXML Help Documentation Reference Guide. This
Reference will provide you with step-by-step instructions for installing
and configuring the ChefXML Software with your POS System or
running a virtual demo.
!
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1 Quick Start
Configuring the ChefXML software is very simple and can all be done
from one application, the ChefXML Configuration. In order to get your
system up and running quickly you do not need to concern yourself
with all of the customized details and features that we offer. Default
settings are provided for most of the maintenance fields and they will
probably be sufficient for what you want to do initially. You can come
back to that later when you have more time and understand the system
a little better. For now all you need to do is a few simple steps.

!

Step 1: Run ChefXML Configuration

!
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Step 2: Select Restaurant Type
Edit -> Restaurant Type
Step 3: Navigate to Global Settings
Edit -> Global Settings
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Step 4: Select System Type
 Demo
Set “KDSWin Compatible”
 DinerWare
Set up a network printer in DinerWare addressed to the
ChefXML PC (not to individual IPad/NGen)
 Others (Coming Soon)
Step 5: Set Software Key
Demo license field is left blank
See Licensing Section for information
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Step 6: Set Number of Videos
Define the number of logical video screens you will use in your
system. This number may be modified at any time to increase or
reduce the number of video's previously defined. Since the
ChefXML supports logical screens this number may not always
reflect the physical number of IPad/NGen devices in your
configuration.
Step 7: Set Maximum Open Orders
The maximum number of orders the ChefXML software maintains
per screen defaults to 50. These include all open orders and
previously bumped orders. After the limit is reached the oldest
order is purged from the order queue to make room for new orders.
Step 8: Set Number of Registers
The number or POS registers configured in the system. The
number selected may be greater than the actual number of register
in the system but should never be less. It is merely used as a
reference for optimizations.
Step 9: Enable Enhanced Record Format (if available)
The ChefXML currently supports the Enhanced Record Format as
well as XML Data Format. These two record formats will allow for
the support of a wide range of new features. It refers to the data
being sent to the ChefXML from the POS software. You will need
to select the option that applies to your particular POS software.
Step 10: Enable Order Recovery (if available)
Order Recovery is a unique and powerful feature that the ChefXML
software offers. Its primary purpose is to maintain a log of all of the
orders as they occur during the day. If the application or PC fail at
any point they can be restarted and everything will be restored to
the exact point that they were at during the point of failure.
A complementary use of this feature is remote troubleshooting.
The Order Recovery Data can be sent to SEC Support if any errors
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or anomalies occur in the field. Armed with the Order Recover
Data and store parameter file (Chef.ini) SEC will be able to
recreate any situation that has occurred. For this purpose alone
we highly recommend that the order recovery feature be
enabled at all times.
Step 11: Enable Text Translation
The Text Translation feature is a very powerful feature whereby
you can alter the text strings received from the POS registers and
which ultimately end up on the remote display. This includes a
simple change of text or a complete change of language. If
disabled then text received from the registers will be displayed
exactly as received. This feature is not limited to text translation
only though. Via text translation you can alter all aspect of how the
item is displayed including foreground color, background color,
icon, routing, prep time, category, etc.
Step 12: Apply New Settings
Once you do this and exit out of the Global Settings window by
"Applying Changes".
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Step 13: Set Video Device Info
Edit -> Video 1,2,…
Step 14: Enter a Name for the Video
Step 15: Enter IP Address for Hardware (Skip to 16 for Demo)
Here we will setup the IP Addresses of the IPads and NGens on
your network. If you are using the Demo ChefXML, skip to the
next section to configure Virtual Videos.
Step 15A: Set IP Address for Each Video
Step 15B: Ensure Hardware is configured with same IP
Address (see Hardware section)
Step 15C: Click “Ping Test”
If the Ping Test PASSED, then move on to the next Video
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(Edit->Video 1,2…). If the Ping Test FAILED, check network
cabling and reset devices to try again. If the Ping Test continues
to fail, consider reassigning IP Addresses
Step 15 Notes: Choosing An IP Address
Ask your System Administrator for a valid range of free IP addresses on the
same subnet as your ChefXML PC.
If you do not have a System Administrator, we have included a quick way
to allocate IP addresses.
First find the IP address of your PC by using Windows IP Config Command
line tool.
Start -> Run -> “cmd”
C:\>ipconfig
IP Address.........................192.168.254.65
Subnet Mask......................255.255.255.0
Once you know the IP Address of your PC you can begin to choose
available IP addresses for your IPads/NGens. Good Practice is to add
some space to account for potential systems that are not currently active
on the network. In the example below, we added 10 to the Host PC IP
Address.
Remember, Video Controllers need to be on the same subnet as the Host
PC (XXX.XXX.XXX.0 to XXX.XXX.XXX.255).
Ping the Host PC:
C:\ >ping 192.168.254.65
Reply from 192.168.254.65: bytes=32 time<1ms TTL=64
….
Ping statistics for 192.168.254.65:
Packets: Sent = 4, Received = 4
….
Ping Candidate IP Address:
C:\ >ping 192.168.254.75
Request timed out.
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….
Ping statistics for 192.168.254.75:
Packets: Sent = 4, Received = 0
….
Continue for Remaining Candidate IP Addresses Needed:
C:\ >ping 192.168.254.76
…
C:\ >ping 192.168.254.77
…
Continue to PING sequential IP Addresses until you have an IP Address for
each IPad or NGen.
Note that this is a simple test though and does not provide a 100%
guarantee that you have chosen a good IP address (consider the possibility
that a PC is turned off and/or not responding) so we do recommend that
you verify IP addresses by all means possible.

Step 16: Enter IP Address for Virtual Video (Demo Only)
Step 16A: Demo IP Addressing
First find the IP address of your PC by using Windows IP Config
Command line tool.
Start -> Run -> “cmd”
C:\>ipconfig
IP Address.........................192.168.254.65
Subnet Mask......................255.255.255.0
For the ChefXML Demo, use the Host PC IP Address for all Video
Controller IP Addresses, since there is no Hardware connected.
Step 16B: Set IP Address for Each Video
Step 16C: Click “Ping Test”
If the Ping Test PASSED, then move on to the next Video
(Edit->Video 1,2…)
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If the Ping Test FAILED, verify that your Host PC IP Address is
the same.
Step 17: Set Device Type Assigned to that IP Address
Step 18: Exit ChefXML Configuration
At this point you have done the minimum that is required to run the
ChefXML software.
You should save the changes you made in the maintenance
screen by exiting out (File->Exit)
Run ChefXML
If everything has been done correctly you should see the active
remote screens ready to display orders.
To view screens Remotely or to view Demo screens in ChefXML
select the Video of interest then Options->View Screen.
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2 Running the Demo
One of the great features of the ChefXML software is the availability of
Managers Windows. A Managers Window is a window that can be
opened up at the PC that provides a view of the remote order display.
In other words you can see what the operator is seeing at the remote
display on the PC that the ChefXML is running on. This is not only
helpful to the manager but is extremely beneficial for running demo's
when no IPad/NGen hardware is available.
To run a demo in this manner simply perform ChefXML Configuration
to setup the screens as you would like them, load the ChefXML
software and "View" the screen you have set up. This will open a
manager’s window that can be minimized and/or maximized. Using the
Register Emulator or other register software you can even generate
bogus orders on the display.
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2.1 Register Emulator
Once the system is up and running and the ChefXML software is
loaded you can begin sending orders to the remote screens. Since
configuring register software is very time consuming and you probably
want to confirm the ability to display orders on your screens NOW we
have provided a "Register Emulator". Using the register emulator you
can quickly and easily simulate samples of basic sales and send them
to the remote order displays.

IMPORTANT: In order to use the Register Emulator and have
orders appear on the remote display's you MUST have the Global
Setting\System Type set for KDSWin Compatible. This is the
default for initial setup. However, this may not work for your
particular register software so don't forget to change it back to
something else when you are done using the Register Emulator
otherwise the orders from your cash register may not appear on
the remote displays.
The Register Emulator software is DEMO SOFTWARE ONLY and is
not intended to serve as a full-featured Register program. Please do
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not send us comments or suggestions on this program. Of course, if
you encounter problems running the program please let us know. The
sole intent of this program is to provide a means for the user to enter
sales that will be sent to the kitchen displays and Managers Screens
through the normal process. This serves as a mechanism for the user
to test the system quickly without having to go through the tedious
steps of setting up his entire POS system and software. It also allows
SEC to step through the process with our customers to verify that they
have done everything correctly without our support staff having to
become familiar with each and every POS system.
To operate the Register Emulator program simply use your mouse to
enter items and/or condiments and cash out each sale when complete.
In order for the Register Emulator to send it's sales to the ChefXML
software you need to make sure that the Global Setting - System Type
option is set to "KDSWin Compatible".
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3 Hardware
This section describes configuration and operation of hardware.
Topics in this section include:
IPad/NGen
Key Functions
Remote Client
Touchscreen
!
!

!

!
!

The ChefXML Software installed on a PC is attached to a Local Area
Network (LAN) as shown in the hardware diagram above. Each video
controller (IPad and/or NGen) is also attached to the same LAN.!
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3.1 IPad/NGen
Since SEC products are used by a wide variety of customers
worldwide and they interface to numerous different software packages,
the IPad/NGen products are shipped from the factory pre-loaded and
ready to configure for many different applications. When you first
receive your IPad/NGen products they should be pre-configured to
interface to the ChefXML software. You will most likely still need to
reconfigure the IP Address to allow them to communicate on your
network. Configuring the units is quite simple and can be done in a
matter of minutes.
The first step in configuring the IPad/NGen is to plug in a PC keyboard
(PS2 or USB) and SVGA monitor (15 pin HD connector) into the
appropriate ports on the device and then apply power. We suggest that
you do not attach the network cable at this point. You will notice that as
the device boots it will stop at a Setup or Configuration screen.
If it does not automatically stop at the setup screen you may need to
depress the F1 key while the unit is booting in order to enter setup.
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By following the instructions provided on the screen you would be able
to configure the device for the register system/software you are using.
In this case you will need to configure the device for use with the
ChefXML software by selecting Remote Client CHEF .
If you have an older device and you do not see an entry for the
Remote Client CHEF software then your device may need a firmware
upgrade before continuing onto the next step. (see How to update an
IPad/NGen with Remote Client software)
Next you will need to assign an IP address to the device. Without a
proper IP address the device will not be able to communicate with
other devices, i.e. your PC, and you will not be able to proceed. (see
Selecting IP Addresses)
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Once the setup has been completed and you save the changes you
have made the IPad/NGen will continue to boot to it's initial screen
where it says "Waiting for server to connect.....". It should also say
Remote Client Software with a version number at the top.
At this point you can remove power from the device, unplug the PC
keyboard, attach the network cable and re-apply power. You will notice
that the device now boots up directly to the "Waiting for server to
connect....." screen. The PC keyboard is only used for configuring the
IPad/NGen so booting without a PC keyboard attached will bypass the
Setup screen altogether.
IMPORTANT: You only need to configure your device one time. This does
not have to be done each time you boot the IPad/NGen. Re-configuring the
device may overwrite your settings and re-configuring the device for any
setting other than "Remote Client CHEF" most likely will prevent your unit
from working properly with the ChefXML software. Booting the IPad/NGen
with the PC keyboard attached will cause your device to initiate the Setup
Menu. Use the PC keyboard only for this purpose. Normal KDS operation
does not require a PC keyboard to be attached.

20110901!

!

www.selectelectronics.com!

!

17!

!!!!!!!!!!!!
!

!

3.2 Key Functions
Keys on the IPad or TouchBar keypad will perform various functions
depending on what mode the screen is in. The default mode for each
screen is Order Mode but using the keypad modes such as Summary
Mode, Help Mode and Production Statistics Mode can be entered.

Keys 1-8
ORDER MODE - Keys 1 thru 8 are used to bump or clear orders from the order
box with the corresponding number.
SUMMARY MODE - No function
HELP MODE - No function
PROD STATS MODE - No function

9 (Right arrow)
ORDER MODE - Bumps or clears the order in box 9 (if visible)
SUMMARY MODE - No function
HELP MODE - Used to scroll down the help list
PROD STATS MODE - No function

CLR Key
ORDER MODE - depressing the clear key will position the orders on the screen
so that the order in box 1 is the first OPEN order. This can be used when
scrolling orders, left or right, to go to a known position. If the CLR key is
depressed for a period of 5 seconds or more the Average Order Timer displayed
on the bottom of the order screen is cleared.
SUMMARY MODE - No function
HELP MODE - No function
PROD STATS MODE - No function
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PARK Key
ORDER MODE - Used to park orders. Available on Drive Thru / split screen only.
Moves order from top portion of screen to bottom portion.
SUMMARY MODE - No function
HELP MODE - No function
PROD STATS MODE - No function

SUM Key
ORDER MODE - Creates and/or refreshes order Summary screen.
SUMMARY MODE - No function
HELP MODE - No function
PROD STATS MODE - No function

RECALL Key
ORDER MODE - Recalls previously cleared order. Each time the recall key is
depressed it will recall the next order.
SUMMARY MODE - No function
HELP MODE - No function
PROD STATS MODE - No functions

ESC Key
ORDER MODE - No function. If the ESC key is depressed for 5 seconds or more
the screen will be toggled between "CLOSED" or "OPENED" (if that option is
enabled) providing a mechanism for the user to open and close individual
workstations during peak and non-peak periods.
SUMMARY MODE - returns screen back to order mode
HELP MODE - returns screen back to order mode
PROD STATS MODE - returns screen back to order mode

REFRESH Key
ORDER MODE - Repaints entire screen.
SUMMARY MODE - No function
HELP MODE - No function
PROD STATS MODE - No function
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HELP Key
ORDER MODE - Displays drop down list with available help. If no help screens
are defined then nothing will be displayed.
SUMMARY MODE - No function
HELP MODE - While the help drop down list is displayed you can scroll up and
down the list with the arrow keys. Once you have located the help you want
depressing the HELP key again will display the available help.
PROD STATS MODE - No function

FUNC Key
ORDER MODE - Displays a menu of available selections referred to as the
FUNCTION MENU.
SUMMARY MODE - No function
HELP MODE - No function
PROD STATS MODE - No function

FUNCTION MENU OPTIONS
1. Production Statistics (displays production statistics report)
2. Alternate Language (toggles languages pre-programmed)
3. Close Station (closes this station)
4. Toggle Routes (changes routing period)
5. Reset Avg Order Timer (reset avg order time at this screen)
*** Items in the function menu that are crossed out are not enabled
*** Items that are highlighted require the key to be held for 5 seconds. to prevent the accidental
selection of these entries. There is no indication on the screen that these keys need to be held
for 5 seconds other than the fact that they are highlighted.

0 (Left arrow)
ORDER MODE - Bumps or clears the order in box 10 (if visible)
SUMMARY MODE - No function
HELP MODE - Used to scroll up the help list
PROD STATS MODE - No function
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3.3 Remote Client
The Remote Client Software is the software that runs on the IPad and
NGen devices and communicates to the Graphics Engine. Since the
ChefXML software sits on top of the Graphics Engine at the PC the
Remote Client technically does not communicate directly to the
ChefXML but for the purpose of this document we will pretend that it
does.
Since the ChefXML interfaces to the Remote Client software you
need to make sure that your remote devices are loaded with and
running the Remote Client -or- IT WILL NOT COMMUNICATE !
Basically the Remote Client is a graphics interpreter and receives its
instructions from the PC. Until it receives these instructions it will not
do much. You will notice that when you first boot the IPad/NGen that it
comes to a screen that says "Remote Client" and "Waiting for server to
connect...." (along with some other information). At this point the
Remote Client is doing just that........"Waiting for the server to
connect......". Until this happens the Remote Client sits idle. This is also
somewhat of a debug stage for the bump bar. Any key depressed will
be echoed on the bottom of the screen so you can verify that your
bump bar is functioning properly.
Once a TCP/IP connection is established between the server the flow
of instructions can begin and screens will paint as the Remote Client
interprets the data. Bump bar keystrokes will now be sent back to the
server and you will no longer get keystrokes echoed on the bottom of
the screen.
The Remote Client and ChefXML software constantly maintain a good
connection and if a connection is lost for any reason (computer goes
down/cable connection/etc.) they will automatically re-establish the
connection and service is restored.
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The Remote Client software has been intentionally limited to run on
SEC's IPad and NGen devices only. The software by nature though is
not limited to any one platform and can in fact run on other devices if
required. If you desire to run the Remote Client on a non-SEC device
please contact SEC.
!
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3.4 Touchscreen
The ChefXML software supports touchscreens as well as the standard
bumping devices. By enabling this feature users can simply touch
areas of the screen to perform all of the functions previously provided
by the bump bar. Bump bars are no longer required.
Configuring a touchscreen by following these simple steps:
1.) Attach a supported touchscreen device to the COM1 port of the IPad or NGen
device using the appropriate cable. (see below)
2.) Using the setup feature on the IPad/NGen device enable and calibrate the
touchscreen.
3.) Enable touchscreen support via the ChefXML Configuration for that device.
4.) Load the ChefXML software and start using your touchscreen monitor.

Currently supported touchscreen(s):
EloGraphics.
Please contact SEC for additional touchscreen brands.

Cable requirements
There are no special cable requirements for attaching a touchscreen to
the NGen. Since the NGen has a DB9 adapter for COM1 it should be
as simple as plugging the touchscreen in using the cable provided by
the touchscreen manufacturer. If an extension cable is required you
must use a straight thru cable.In order to attach a touchscreen to the
COM1 port of an Ipad it will be necessary to use a DB9-RJ45 adapter.
This adapter must be pinned to provide a null modem. The correct
DB9-RJ45 Male adapter Pinouts are as follows:
Pin 1 - Blue
Pin 2 - Orange
Pin 3 - Black
Pin 4 - Red
Pin 5 - Green
Pin 6 - Yellow
Pin 7 - Brown
Pin 8 - White
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4 Screen Options
This section describes configuration of options to customize the video
screens.
Topics in this section include:
Screen Type
Screen Layout
Color Definitions
Invert Image
Span Screen
Screen Saver
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4.1 Screen Type
The ChefXML supports various screen types or definitions. Each
screen type provides certain functionality. Selecting the correct type to
fit your needs is important.
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AD SCREEN
An ad screen is simply as stated, an advertisement screen. There is no
relation to the food preparation or order filling aspect of the business.
The purpose of the ad screen is to provide a means to display
constant, scrolling advertisements to your customers in the lobby area,
or window, or any other area of your restaurant. Ads can be created
using standard JPG and BMP formats and can be scheduled using the
AD SCREEN maintenance feature.
DISABLED
As defined this screen would be disabled. This allows customers with
multiple locations to provide a single ChefXML configuration file that
would accommodate all stores even though each store may have
different numbers of screens.
DRIVE THRU
The drive thru display is the same as the expediter display in that it
does not perform item routing but has the added capability of being
able to park orders. In certain systems it can auto bump orders once
they have been tendered at the drive thru register.
DRIVE THRU w / IMAGES
This video type operates the same as a normal drive thru but includes
an area within each order box that can display images sent to the
ChefXML software in the form of JPG and BMP files from a video
surveillance system representing the customer at the drive thru
window.
EXPEDITER
The expediter display is very similar to the food prep except that it
does not perform item routing. All items regardless of route will display
at this monitor. You do still have control over which registers will send
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their orders to this display type. Also, the expediter display can
highlight items as they are bumped / prepared at food prep monitors.
EXPO W/ROUTING
The functionality of the EXPO w/Routing is the same as stated in the
EXPEDITER with the exception that certain items can be routed to this
display as opposed to receiving all items regardless of route.
FOOD PREP
As one would expect use this type for all food prep displays. Item
routing can be performed at all food prep monitors.
ITEM
The ITEM display is most useful in a table service environment but it
can be used elsewhere. Basically all items will be displayed line by line
on the screen as opposed to a complete order. This is a food prep type
display meant to help the cook in cases where they don't need to
associate each item with the entire order.
SPANNING
A spanning video serves as an extension to another video and
assumes the same personality. Using spanning videos multiple
display's can be mounted side by side so that when one screen fills up
with orders the next order can overflow onto the next screen thereby
allowing for more orders to be displayed at one location.
4.2 Screen layout
Allows you to select the screen configuration that best suits your
needs. The 3x2, 4x2 and 5x2 styles allow more orders to fit on the
screen at one time. The 3x1,4x1 and 5x1 provide elongated columns
and allow for larger orders to fit in a single box.
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4.3 Color definitions
The color definitions area allows you to select the colors that best suit
your needs for certain items on the display. Currently this list is very
limited and some of its functionality may be moving to provide more
power to the user.
4.3.1 Apply default colors
Change all color settings to their recommended defaults.
4.4 Invert Image
The ChefXML provides the unique feature of allowing the screen
image displayed to be inverted or upside down. Although this may
sound like a strange feature consider the possibility of mounting a flat
panel display upside down from its base. It could be mounted under a
shelf or on a low ceiling with no additional hardware. Turning this
feature on allows the screen image to then appear correctly.
4.5 Span Screen
This field only appears if you have selected a Spanning Screen type
and indicates which screen will have its orders overflow to this
particular screen. Multiple screens can be spanned creating an entire
wall of orders.
4.6 Screen saver
The screen saver feature allows you to program a preset time, in
minutes, whereby the screen would go blank. In order for the screen
saver to kick in there must be no orders on the screen and no activity
at the screen for that period of time. While in screen saver mode any
new order or any depression of a key at the bump bar will refresh the
screen and screen saver timer. Any bump bar key depressions while in
screen saver mode will not affect the orders on the screen and will only
serve the purpose of refreshing the screen. Any subsequent key
depressions will be processed as a normal key hit.
!
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5 Item Options
This section describes configuration of options to customize the display
of menu items.
Topics in this section include:
Adding Items
Languages
Prep Time
Routing
Categories
Icons
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Text translation provides a powerful method for altering the text that
has been received from the POS prior to displaying it on the remote
display. Text translation can be used for something as simple as
changing HAMBURGER to display BURGER, changing the foreground
color and/or background color of each line, or it can be used for
something as complex as changing languages. Future releases of the
ChefXML will offer additional capabilities via the text translation
feature, which will allow text to be changed to ICONs or images.
Originally translation was limited to ITEM and CONDIMENT lines but
now offers translation of all line types including headers, messages,
trailers, etc.
5.1 Adding Items
The Text Translation table entries are stored in a specific file, which
should be limited in size to the maximum table entries that you will
foresee needing. Specify here the quantity of table entries in your
kitchen text translation.
5.1.1 Learn Mode
The Text Translation feature has the capability of capturing and
learning the ITEMS and CONDIMENTS it receives from the POS
registers. Let's face it, these items and condiments have already been
entered once within the POS Maintenance and no one wants to do this
work twice. These items will be stored in the Text Translation table for
further modification. Of course, if there are only a few strings that need
to be altered then simply disable learn mode and enter them manually.
5.1.2 Manual Entry
The Text Translation table contains an alphabetized list of all of the
current entries in the table whether they be manually entered or
learned. New entries are manually entered simply by selecting <ADD
ITEM TO LIST>. Entries can be purged from the list by highlighting the
item in the Text Translation Table and depressing the <Delete> key on
your keyboard.
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5.1.3 Import
Coming Soon
5.2 Language
The text translation is individually controllable at each remote display.
This allows the user at one screen to view orders in one language
while the user at another screen is viewing a different language. When
the ChefXML software is initially loaded all screens will display in the
same base language. Each screen can be altered, at any point, to
display an alternate language using the bump bar. The conversion is
instantaneous.
5.2.1 Conversion (Base Language)
This is the primary conversion string, also called the base language. If
this field has been programmed then, each time the Text String is
received, it will be converted to and displayed as this string. When this
field is not programmed the original text received from the POS will be
displayed "as is" and no conversion will occur.
5.2.2 Alternate Language 1
This field may be programmed to contain an alternate language. The
language that each screen independently displays is selectable at the
bump bar. If the user chooses Alternate Language 1 at the bump bar
then this text will be displayed in place of the original text received from
the POS. If this field is left blank then either the original text or
conversion text will be displayed.
5.2.3 Alternate Language 2
This field may be programmed to contain an alternate language. The
language that each screen independently displays is selectable at the
bump bar. If the user chooses Alternate Language 2 at the bump bar
then this text will be displayed in place of the original text received from
the POS. If this field is left blank then either the original text or
conversion text will be displayed.
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5.3 Prep Time
This represents the amount of time an item takes to prepare in the
kitchen. This feature is generally used in a table service environment to
insure that all items are completed at the same time. The ChefXML
has built in "scheduling logic" that will send orders to the food
preparation screens on a timed basis.
5.4 Routing
This feature allows the user to select which video screens each item
will be sent to. In most cases the routing information will be provided
by the POS and does not have to be duplicated here. However, with
systems that do not have the capability of provide routing information,
which may be the case with certain ECR's, the routing information can
be entered here.
5.5 Categories
Categories are groupings of items. By default all items are displayed in
the order they are received and categories do not need to be defined.
In a quick service environment categories may be used to sort or
prioritize items. By assigning categories to items they will be sorted
prior to display such that all items from Category 1 will be displayed
first, followed by category 2 and then category 3, and so forth.
Categories may also be useful in a table service operation where you
want items to be grouped by course such as Appetizer, Entrees and
Desserts.
5.6 Icons
This feature allows the user to associate an Icon or image with a
particular item. At the current time this feature is only used to support
certain features but will be expanded in the near future to support a
wide range of features.
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6 Workflow Options
This section describes configuration of options to customize the
workflow in the kitchen.
Topics in this section include:
Course Timing
Prep Timing
Routing Options
Register Options
Bumping Options
Audio Options!
!
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6.1 Course Timing
Courses, also called Inter-Category Delays, allows food of a specific
course or category to be delayed to allow the natural rhythm of a meal
(appetizer, entrée, dessert, etc). In addition to being grouped together
items can be sent to the display on a timed basis. This is typically a
table service feature and has no real value in quick service. The
ChefXML software has a complex algorithm it uses to calculate the
proper time to send items to the display to insure that all items are
completed at the same time for delivery to the customer. This algorithm
factors in the prep times for each item, as defined in the text translation
table, as well as the inter-category delay. The inter-category delay
is defined as the ideal amount of time, as determined individually by
each restaurant, in between each course. Access Courses in by
setting your Restaurant Type to Table Service (Edit->Restaurant Type)
then selecting Categories (Edit->Categories).
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6.2 Prep Timing
6.2.1 Prep-Level Indication
This option (“Highlight prepped Items” under the Misc Tab) allows
items on this display to be highlighted as they are bumped at the
various food prep monitors. This is done by transaction ID.
6.2.2 Ideal Prep Time
Each order on the display will have an elapsed time clock associated
with it. The Ideal Prep Time is the ideal amount of time it should take to
prepare an order in this establishment. It can be set to indicate that an
order has been pending for a while and needs attention. Once the
Ideal Prep Time has been exceeded for any particular order the clock
on the displays will be highlighted in yellow. This also flows through to
the Speed of Service reports.
6.2.3 Maximum Prep Time
Each order on the display will have an elapsed time clock associated
with it. The Maximum Prep Time represents the maximum allowable
time for any given order within this establishment. The Maximum Prep
Time indicates that the order has top priority and must be completed
immediately. Once the Maximum Prep Time has been exceeded the
clock on the displays will be highlighted in red blinking text. This also
flows through to the Speed of Service reports.
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6.3 Routing Options
6.3.1 Routing Schedules
Routing periods provide methods for changing the routing schemes at
various intervals during the day. By default there is only one routing
period but up to 8 routing periods can be defined (1 Primary and 7
Alternates). Within the routing period maintenance screen you will
provide a descriptive name for each of the routing periods you need.
Any routing period that does not have a definition assigned will not be
used. In this manner you can program the number of routing periods
required. On the Routing Periods entry, found in the Edit menu, you
will be able to define the re-routes taken for each screen during each
routing period. When the ChefXML software is initially loaded it will
use the Primary Routing scheme. To change to a different route at any
point during the day simply use the drop-down list available on the
ChefXML screen or via the IPad function menu.
6.3.2 Rerouted Orders
This option (“Send Parked Orders To”) is only available on Drive Thru
type displays. It allows orders that have been parked to be forwarded
to another display. Perhaps the bottom half of a split screen display.
6.3.3 Reroute downed video
Orders can optionally be rerouted to another video if for some reason
this video is not responding due to abnormal issues such as a
hardware problem, power or cabling issue.
6.3.4 Send orders from CLOSED station
During various work loads stations can be opened or closed via the
bump bar and orders rerouted to other screens. This may be helpful in
a double-sided grill scenario. During peak periods both sides of the grill
might be used and during non-peak periods only one side will be
opened.
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6.3.5 Merge closed station with alternate
When a video is closed and it's orders are being forwarded to another
station the orders can be mixed in with the orders already going to that
other station or merged. Merged means that the video being closed will
be displayed on the alternate station as a split screen. The top half
represents the original screen and the bottom half is the screen that
was just closed.
6.4 Register Options
Select Video Settings (Edit->Video1,2..) and choose the Bump Events
Tab.
6.4.1 Register routing table
Each video can individually be programmed to allow orders from all
registers or certain register to display. An example of this would be to
have drive thru register only display on the drive thru screens or to
have counter registers only display on certain displays.
6.4.2 Disable item consolidation
Items can either be displayed in a consolidated manner or unconsolidated. By default some registers may send their orders in a
consolidated mode so this option is rendered useless and orders will
be displayed consolidated only.
6.4.3 Unique transaction numbers
If your POS system generates a unique transaction number for each
and every orders/tickets then this option should be turned on. If each
POS workstation is capable of generating a range of transaction
numbers (exa. 1-100), whereby the same transaction number can be
generated by two different POS workstations, then this options needs
to be turned off.
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6.5 Bumping Options
Select Video Settings (Edit->Video1,2..) and choose the Bump Events
Tab.

6.5.1 Allow Individual Item Bumping
This feature allows for the bumping of individual items within an order
as they are processed. The items are not actually removed from the
original order but are highlighted or crossed out so that it is clear to the
user that these items have been processed. In this manner the original
order remains intact to reduce any potential confusion. It is very
important to understand the complete functionality of this feature
before enabling it since the bumping of orders will operate differently.
Under normal circumstances (item bumping = disabled) orders are
bumped from the displays simply by depressing the box number
associated with that order. Item bumping is not available. Once the
item bumping feature is enabled this is no longer the process.
Depressing the box number associated with any given box will now
open a new window displaying that entire order. At this point the order
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can be bumped by immediately depressing the CLR key -or- an item
can be bumped by scrolling down to that item and then depressing the
CLR key -or- the window can be closed by depressing the ESC key.
Multiple items can be selected for bumping while the window is open.
In this manner the process for bumping an order is now a twokeystroke procedure. However, we did preserve the capability to bump
the order in box #1 with a single entry. To bump the order in box #1
using a single keystroke simply depress the CLR key prior to opening
an item bump window.
6.5.2 Bump actives
Enabling this option will allow the operator to bump orders from the
display even prior to the order being completed.
6.5.3 Auto bump
The auto bump feature allows orders to be bumped by the system
automatically, with no user intervention, at a preset elapsed time.
6.5.4 Remove orders as they are bumped at other screens
This feature allows orders to be removed from this screen once it has
been bumped at any other screen. This is done by order number. This
may be useful for an expediter screen for example. Once the order has
been cleared by the expediter it must have been prepared and it only
makes sense to remove it from the food prep screens as well.
6.5.5 Send bumped orders to video
Once orders are bumped they can be automatically forwarded to
another video in the system. This can be useful in production lines
where the food or tray moves down the line.
6.5.6 Send bumped orders to printer
Once orders have been bumped they can be sent to a remote printer
where a chit will print containing all of the information that had been
displayed. Remote printers can be connected to the COM2 port of any
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IPad/NGen device in the system. Printer output data is 9600 Baud, 8
bits, No Parity, 1 Stop bit.
Currently SEC supports any EPSON or EPSON compatible printer.
Please contact SEC if you wish to support another brand of printer.
6.5.7 Allow modification / redisplay of bumped orders
This option is only made available for Pixelpoint users. Due to the way
that Pixelpoint sends it's transaction data to the ChefXML it is possible
that an order that has already been bumped to reappear on the kitchen
monitor if a modification has been made to the order at the POS after
the fact. This option will allow the ChefXML to block this order from
being redisplayed at the kitchen monitor if it had been previously
bumped.
6.5.8 Reset clock on "Bump To" orders
This option allows the order clock to be reset to 00:00 when bumping
from one screen to another. Otherwise the value of the order clock will
be passed to the "bump to" screen along with the order.
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6.6 Audio
Select Video Settings (Edit->Video1,2..) and choose the Audio Tab.

6.6.1 Order beeper
Typically a beeper sounds at the bump bar when new orders arrive to
notify the cook that something needs his attention. The order beeper
can be turned off altogether (None), or can be programmed to sound
each time a new order comes onto the display or only when the first
order comes onto the display.
6.6.2 Tone style
Allows for the programming of various tones to be used by the order
beeper. The default is an alternating tone that plays for roughly 1
second. Other available tones are continuous tones that will play until
an operator depresses one of the keys on the bump bar. Any key
depressed to turn off the beeper will not be registered in the software
as a valid keystroke. Continuous tones may be useful in operations
where users routinely walk away from the screens but may add
unwanted noise to an already noisy environment.
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7 Management Features
7.1 Management Window
Managers Windows can be opened at the PC and allow you to view
the information on any of the remote screens. Now the Managers
Windows has an integrated bump bar that allows you to process orders
for demo purposes. This can be done at any time and can be done
without having any remote devices such as the IPad or NGen attached
to the system. In this manner you can preview the software or run a full
demo even prior to purchasing hardware. To access management
window from the ChefXML highlight the Video you would like to
monitor and navigate you Options->View Screen
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7.2 Management Reports
Through ChefXML managers can gain insight into their Kitchen
operations like never before.

!!!!!!!!!

!

7.2.1 Core Reports
The ChefXML Report processor provides Speed of Service reporting
based on historical data that has been collected for up to one year. All
reports are generated in HTML format and opened with the default
browser. By default the report processor will generate reports for the
current day but a date range can be selected using the "Start date" and
"End date" calendars. Filters and sorting options are also provided to
customize the report to your needs.

!!!!!!!!!
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7.2.2 Advanced Reports
For those users that require their own custom reporting capabilities
there is an export function that will allow the Speed of Service data to
be exported to a comma separated format (CSV). Select Electronics
Corporation can also provide custom reports based on individual
request.

!

!

7.2.3 Real-Time Production Statistics
At the KDS Screen, the manager can access production statistics
about the Speed of Service in recent time.

!
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8 Recipe Screens
The ChefXML supports recipe or help screens that are accessible at
each remote display individually. As shipped from the factory there are
a few sample help screens. It is very easy to create, install and support
your very own help screens to assist in food preparation, kitchen
operations, training, etc.. Help screens may include text, graphics,
pictures, instructions etc. for whatever you desire to be displayed on
the remote screens.

8.1 Applications
Recipes
Create graphical recipes to be able to lookup menu items and their
cooking instructions at the KDS Video.
End-of-Day Checklists
Create a graphical end of day checkout procedure that can be
displayed at every KDS Video.
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8.2 Recipes Design / Setup
1.) Create your own graphics file and save it as a Bitmap image or Jpg
file. You can create these images using any popular tool or simply
scan existing documents from your scanner. The ChefXML software
will display all images as full screen, 800x600, true color images. For
best result you may want to create files that are already 800x600 but
this is not required. The ChefXML software will automatically size the
image to fit the entire screen.
2.) Save the resulting file in the \Select Electronics
Corporation\ChefXML\Help subdirectory. We recommend that you use
a meaningful file name (such as "Hamburger Build Instructions")
because this is what will show up on the Help drop down list at the
remote display's.
You may also want to delete the sample help files that we have
provided to prevent them from appearing on the help list.
!
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9 Signage
Advertisement screens can be created to convert any LCD display into
a billboard that generates additional sales via suggestive selling. Ads
must be created in standard JPG or BMP formats and can be stored
anywhere on the local hard drive in order to be scheduled via the Ad
Screen maintenance. Ideally ads will be created in 800x600 true color
mode but ads of any size and shape can be displayed. Ads that do not
require an entire screen will be stretched to fill the entire screen.

!

!

!
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9.1 Signage Setup
Go to Desired Video Settings (Edit -> Video 1,2,…) and set System
Type as “Ad Screen”.
!

9.2 Signage Design
The purpose of the ad screen is to provide a means to display constant
or scrolling advertisements to your customers in any area of your
restaurant. Ads can be created using standard JPG and BMP formats.
!

1.) Create your own graphics file and save it as a Bitmap image or Jpg
file. You can create these images using any popular tool or simply
scan existing documents from your scanner. The ChefXML software
will display all images as full screen, 800x600, true color images. For
best result you may want to create files that are already 800x600 but
this is not required. The ChefXML software will automatically size the
image to fit the entire screen.
2.) Save the resulting file in the \Select Electronics
Corporation\ChefXML\Ad subdirectory.
3.) Choose signage by Edit->Ad Screens

!
!
!
!
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10 Advanced Features
10.1 Fault Tolerance
Fault Tolerance allows you to configure two separate PC's to run the
ChefXML software, a Primary system and a Backup system. If the
Primary system goes down the Backup system can automatically take
over KDS operations. If the Primary PC returns to operation it will
resume it's roll as the Primary KDS service and the Backup system will
return to an idle state.
10.1.1
Primary / Backup
Since the ChefXML will be installed on two different PC's when fault
tolerance is being used this option will indicate if this system is the
"Primary system" or the "Backup system".
10.1.2
Initiate Crossover
The fault tolerance feature can be programmed to automatically cross
over to the backup system if the Primary system fails or to do so
manually. If automatically is chosen then the crossover will take place
without the operators noticing. If manually is chosen then the manager
will be notified when the Primary system goes down and it is his option
to allow or disallow the crossover to backup.
10.1.3
Backup IP Address
This tells the Primary system the IP address of the Backup PC so that
he can establish a connection with it. If this version of the ChefXML
software is running on the Backup PC then this option will request a
"Primary IP Address”.
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11 Licensing
11.1 Demo License
Demo licenses are free of charge provided that the software is not
used in an operational kitchen for the purposes of conducting
business. The license is full featured, but contains a time-out, which
requires the software to be restarted.
11.2 Full License
Full licenses can be purchased by contacting Select Electronics. Visit
www.selectelectronics.com for our latest contact information.
!
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12 Troubleshooting
12.1 FAQ
12.1.1
Where is KDSData?
Virtually all files used or created by the ChefXML software will reside in
the directory the ChefXML software was installed in or one of it's
subdirectories. The KDSData file is one of the exceptions. One of the
mechanisms POS companies will use for transferring their sales data
to the ChefXML will be via file I/O. They will place their transaction data
in the KDSData file and the ChefXML software will process that file and
send the orders to the various displays. Once the data is obtained from
the KDSData file all aspects of the kitchen displays are handled from
by the ChefXML from that point on.
Every POS company may create their respective KDSData file in a
different directory, perhaps a directory of their own. It is imperative that
the KDSData file directory location be correctly specified otherwise no
sales data will be processed and orders will not go to the displays.
The Register Emulator software that SEC provides utilizes this
parameter as well and it is virtually impossible to have it wrong for
order simulation purposes. However, when simulated orders from the
Register Emulator successfully display at the remote devices and
orders from the POS will not this is a good indication that this option is
incorrectly configured and not pointing to the POS vendor's KDSData
file.
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12.1.2
How do I update IPad/NGen Remote Client?
The ChefXML software communicates to the remote devices via
TCP/IP, which is a connection-oriented protocol, and offers many
benefits over the older method of communication provided by SEC.
This will require the remote devices to be running software that does
the same. The Remote Client , which is the software that runs on the
IPad and NGen devices, will provide this functionality. If you just
recently purchased your IPad or NGen device, it is likely packaged to
include the Remote Client software, which may just need to be
activated via the device setup screens. If you purchased your device a
while back chances are you will need to update the firmware. This can
be done fairly easily but may require you to install our Dashboard
software if you do not already have it. Here are some simple steps to
perform this task....
1.) Execute the Dashboard software. (If it is not communicating with your remote
devices you may need to configure it first).
2.) Click on the device you need to update in the upper right hand window.
3.) Click on the Play Script button
4.) Search for the Remote Client Update script. We have included that in the
installation and it can be found at \Program Files\Select Electronics Corporation\
ROD Gold\Scripts\RemoteClientUpdate.dsf
5.) Play the script until completion.
6.) Repeat these steps for each device in your system.

When using the Remote Client, future software updates are much
easier and will be well worth the steps needed to install it in your
system.
!

20110901!

!

www.selectelectronics.com!

!

52!

!!!!!!!!!!!!
!

!

12.1.3
How do I configure Network Printer and Print Codes?
The ChefXML can be configured to receive and process data that is
originally designed to go to a network printer. Typically these textbased printers will receive print codes, commonly referred to as
escape sequences, to tell the printer to perform certain functions. As it
relates to the ChefXML though these print codes are not very useful
and in most cases need to be ignored altogether. In order to properly
remove all of the data in these print codes, which may contain valid
printable characters, the ChefXML must maintain a table of these print
codes. (Edit->Print Codes, Edit->Filters, Edit-> Print Hub Settings)
Adding a print code - To add a new print code to the table simply
enter the print code into the print code text box and depress the
Add/Modify button.
Deleting a print code - To delete a print code from the table highlight
the print and depress the Delete key on your keyboard.
Modifying a print code - To modify an existing print code entry just
highlight the print code, modify the code in the print code text box and
depress the Add/Modify button.
Valid Print Code Entries
<ESC> - the print code text box will initially contain and ESC code since this is
the most common print code. This code equates to a decimal 27. If your print
code does not start with an <ESC> just delete it from the text box and enter your
complete code.
<nn> - to enter a non-printable ASCII character as part of your print code enter
the decimal equivalent in between "<" and ">". <0> is not valid.
t - to enter a printable ASCII character as part of your print code simply enter that
character
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Sample print codes:
<ESC>c - set color command
<ESC>G - enhanced print
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12.2 Register Specific Help
12.2.1
BlackBoard
Coming Soon
12.2.2
DinerWare
Ring up a sale and look to ChefXML folder for the existence of
secdinerware.txt
If it does not exist, Contact DinerWare Support because ChefXML is
not receiving orders. Please note that DinerWare orders are send to
the ChefXML and not to the individual IPad/NGen.
If it DOES exist, submit to SEC Support
12.2.3
FuturePOS
Coming Soon
12.2.4
Generic Network Printer (with DEF)
Coming Soon
12.2.5
Generic Network Printer (Standard)
Coming Soon
12.2.6
MicroPlus
Coming Soon
12.2.7
PixelPoint
Coming Soon
12.2.8
Sharp
Coming Soon
12.2.9
SMS Touch
Coming Soon
12.2.10 SoftTouch
Coming Soon
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12.2.11 Standard TCP/IP
Coming Soon
12.2.12 SubShop
Coming Soon
12.2.13 Total Touch
Coming Soon
12.2.14 Xyng
Coming Soon
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12.2.15 NCR GenPOS
Setting the System type to NCR GENPOS within the Global Setting will
enable a new screen for programming the NCR GENPOS Options.
Any options specific to the NCR GENPOS software will be
programmed here. In addition, if NCR GENPOS is selected for system
type the "GENPOS Packet Processor" provided by SEC will auto load
each time the ChefXML software is loaded. The GENPOS Packet
Processor is responsible for receiving GENPOS transaction data and
forwarding it to the ChefXML.
Suppress unique transaction # line
The GENPOS software has the ability to send a header line that
includes information such as store/recall number (S/R#) or guest check
number (GC#). It also can send a separate line that includes the
"Unique Transaction #". Normally this additional line will be displayed
on the remote screens along with the header information. The
displaying of this line can optionally be suppressed by enabling this
feature.
Master IP Address
This field allows the GENPOS Packet Processor to identify the master
GENPOS register. In previous versions of the GENPOS Packet
Processor this was entered as a command line parameter which is no
longer required.
Enhanced packet format
Newer versions of GENPOS software use an Enhanced Format for
sending data to the kitchen displays. Older versions, such as the 7448,
have a smaller packet and provides less information to the kitchen.
This option is turned on by default but if you are experiencing problems
and cannot recognize valid packets within the Packet Processor then
you may have older GENPOS software and may need to turn this
option off.
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Enable Order Confirmation Board
Currently the ChefXML support only a Texas Digital, RS232 order
confirmation board. Eventually it will support our very own order
confirmation board as well. However, until that time this option will
allow you to enable or disable the Texas Digital display. Once enabled
a new window with option settings required to configure the Texas
Digital display will appear.
Automate drive thru
The Drive Thru displays have the ability to run in an automated mode
so that the bump bar is not required for normal processing of orders.
Since the drive thru is a natural first in-first out queue orders can be
bumped from the drive thru display automatically as they are recalled
by the POS system. In this manner the first order on the display, the
one found in box 1, always represents the car at the window.
Another function of the automated drive thru is break in orders. If a car
pulls up to the window without first placing an order or if the customer
at the window wants to add to their order after they have already paid
then that order will be handled as a special order and will be displayed
in a pop-up window at the drive thru screens.
PCD202 Attached to
The ChefXML supports a tax and total display for drive thru operations
in conjunction with the GENPOS Packet Processor. The PCD202
Model can be attached directly to the COM2 port of any one of the
IPad or NGen devices. If there is no PCD202 device in the system this
option should be programmed for "None". Otherwise, select the device
ID that the PCD202 will be attached to and the ChefXML will send tax
and total data 9600,N,8,1 to that location
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OCB Comm Port
The RS232 communication port that the Order Confirmation Board
(OCB) is attached to. This will be located on the PC that the ChefXML /
GENPOS Packet Processor software is running on.
Order Taker Register
The order taker register is the POS register in the drive thru that orders
are initially being entered at. If the drive thru consists of a single
register then enter that register number here. If the drive thru system
consists of two POS registers then usually the first register is the Order
Taker and the second register is the Cash Taker. The Order Taker
register will also be the primary register involved in sending orders to
the OCB.
Cash Taker Register
The Cash Taker register is the POS register in the drive thru that
orders are finalized at. If the drive thru consists of a single register then
enter that register number here. If the drive thru system consists of two
POS registers then the usually the first register is the Order Taker and
the second register is the Cash Taker. The Cash Taker register will
serve as the alternate register involved in sending orders to the OCB.
Display Coupons
Typically coupons are not displayed on the remote monitors. and by
default all Coupons are disabled from displaying at the remote
monitors. However, there may be times when this information is
required at the remote monitors to determine bagging information so
individual coupons can be enabled and will display at the remote
monitors as a seperate message line.
!
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